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Legal Notices
Warranty

The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying.
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government
under vendor's standard commercial license.

Copyright Notice
© Copyright 1994-2011 Hewlett-Packard Development Company, L.P.

Trademark Notices
Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.
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Documentation Updates

The title page of this document contains the following identifying information:

¢ Software Version number, which indicates the software version.

+ Document Release Date, which changes each time the document is updated.

o Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and log on. To register for an HP Passport
ID, goto:

http://h20229.www2.hp.com/passport-registration.htmi
Or click the New users - please register link on the HP Passport log on page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:

o Search for knowledge documents of interest

o Submit and track support cases and enhancement requests
o Download software patches

« Manage support contracts

e Look up HP support contacts

¢ Review information about available services

¢ Enterinto discussions with other software customers

o Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.htmi
To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Overview

This document is an overview of the changes made to Service Manager (SM) for version 9.21.030
Patch 1, and for Service Request Catalog 1.20 patch 1. It contains important information that is not
included in books or Help.

What's New in This Release?

There are no new Service Manager features in this release, but there are enhancements that will
significantly improve Service Request Catalog performance.

Service Request Catalog

There are no new features in this release, but there are enhancements that will significantly improve
run-time performance. To incorporate these performance enhancements, make sure that you
complete the Service Manager dbdict configuration steps described in Chapter 2 and 3 in the HP
Service Request Catalog 1.20p1 Installation and Configuration Guide.

The Service Request Catalog .war file for this release contains complete language packs for the Ul
and Help.
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Installation

The instructions for installing this release assume that you have already installed HP Service
Manager 9.21.

Web tier update

The Web tier update consists of a compressed file, sm921.030-P1 Web Tier.zip. The
specific upgrade process depends on your particular web application server, but follows the same
steps as deploying a new installation. For more information, refer to the HP Service Manager 9.20
Installation Guide.

The upgrade does not automatically save your Web tier customizations. To keep your changes, you
must save your customized files and replace the new version of these files with your customized
version.

To install the web tier update:

1.

5.

Back up your web . xm1 file, splash screen, style sheets, and any other customizations you
made, including your webtier-9.21.war file.

Delete or uninstall the existing webtier-9.21.war file.

Note: The "Update Application" function in WebSphere Application Server 5.x allows you to
redeploy using a new copy of webtier-9.21.war. First, update the web . xm1 in the
webtier-9.21.war file, and then redo the shared library configuration. For more information,
see the IBM WebSphere documentation.

Deploy the new webtier-9.21.war file following the instructions in the HP Service
Manager 9.20 Installation Guide and the following Knowledge Base article, IBM WebSphere
5.0, DocumentID SA6-41F-LBJA, Deploying the Service Manager Web tier to WebSphere 5.0.

Replace the new versions of the files you customized with your customized versions, including
the web . xm1 file.

Restart the web application server.

Windows client update

The client update consists of a compressedfile, sm9.21.030-P1 Windows Client.zip,
which contains client.exe.

To install the Windows client update:

1.
2.

Stop the Service Manager Windows client.

Uninstall the Service Manager Windows client. (Your connection and personalized settings are
retained.)

Runthe client.exe andinstall the client by following the instructions in the HP Service
Managerinstallation Guide and Release Notes for your version.

Check the version in Help > About Service Manager. The client should be Release: 9.21.030.
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Server update

The server update for your operating system (OS) consists of a compressed file, sm9.21.030-
Pl <0S>.zip.

(or .tar), which contains the Service Manager server files. These files replace the equivalent files in
the [SM Root] \RUN([SM Root]/RUN )directory.

To install the Server update:

1. Stop all Service Manager clients.

2. Stop the Service Manager server.
3. Make a backup of the RUN directory.
4

Extract the compressed files for your OS into the main Service Manager directory on the
server. The default pathis: C: \Program Files\HP\Service Manager 9.21.

For Unix servers, set the file permissions for all Service Manager files to 755.
Restart the Service Manager server.

Restart the Service Manager clients.

© N o O

Check the version in Help > About Service Manager. The server should be Release: 9.21.030.

Applications update

The applications update consists of the unload files that come with the server update. When you
extract sm9.21.030-P1 <0S>.zip (or .tar ), it will add the new files to your

[SM Root]\RUN\platform unloads ([SM Root]/RUN/platform unloads )directory.

In order to take advantage of the all server changes, you will need to load the following application
unload files:

e QCCRIE55715 sSM921pl.unl, which fixes anissue when multiple users tried to log into the
web client at the same time. Refer to QCCR1E57153 for mor information.

e QCCRIE57767 SM921pl.unl, whichincludes application changes to reduce jgroups traffic on
login. Refer to QCCR1ES57766 for more information.

e QCCRIE59753 SM921P1.unl, which fixes the banner. Refer to QCCR1E59753 for more
information.

To load an unload file:

1. Make sure the Windows client is configured for a server side load/unload.
a. From the Windows client, go to Window > Preferences > HP Service Manager.

b. Unselect Client side load/unload if it is flagged.
c. Restart the Windows client.
2. Open Tailoring > Database Manager.
3. Right-click the form or open the options menu and select Import/Load.

4. Fill in the following fields.
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Installation
File Name Type the name and path of the file to load.
Import Descriptor Since unload files do not require an Import Descriptor record,
leave this field blank.
File Type Select the source operating system of the unload file.

Messages Option — All | Select this option to see all messages that Service Manager

Messages generates loading the file.

Messages Option — Select this option to see only the total number of files Service
Totals Only Manager loads.

Messages Option — Select this option to hide all messages that Service Manager
None generates when loading the file.

Note: You can view the contents of an unload file before importing it by clicking List Contents.

5. Click Load FG.
SRC Update

To perform the SRC update, follow the instructions in the HP Service Request Catalog 1.20p1
Installation and Configuration Guide, included with this release.

Note: Service Request Catalog is a optional feature. You can take advantage of Service Manager
9.21p1 without installing or updating SRC components.
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Known Issues

The reference number for each defect is the Quality Center Change Request (QCCR) number. For
more information about open defects, visit HP Software Support Online, or contact your HP
Support representative directly.

Service Manager

These are known issues in Service Manager 9.21p1.

QCCR1E58335

Problem On the Windows client, the user cannot add criteria by selecting from a combo list
in the advanced search filter.

Workaround | None available at this time.

QCCR1E58336

Problem On the Windows client, redundant items display in the combo box after a user
makes a selection in the drop-down list in the advanced search filter.

Workaround | None available at this time.

QCCR1E60525

Problem In the web client, when you add a tab with a text area for assignment groups, users
cannot then update the assignment group properly. After you add new operators
and save, the operators appear twice on the list.

Workaround | None available at this time.

QCCR1E60816
Problem In the web client, the Navigator Menu may disappear after a user refreshes the
browser.

Workaround | None available at this time.

QCCR1E60844

Problem In the Windows client, pressing CTRL+SHIFT+END does not display the last
record in the list in the detail pane.

Workaround | None available at this time.

QCCR1E60849

Problem The group items and group count in a search list are not correct after a record is
removed from the search list because it no longer matches the original query.

Workaround | None available at this time.
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QCCR1E60925

Problem The web client may hang when a user views a form in Forms Designer.

Workaround: | None available at this time.

QCCR1E60931

Problem Logout page should show as whole page not just in a tab when using LWSSO.

Workaround | None available at this time.

QCCR1E60934

Problem The cursor.field.contents() function does not work for a blank/read-only field if
cursor was previously set to a Text/Date/CompFill/Combo Object.

Workaround | None available at this time.

QCCR1E60986

Problem SM process throws a signal 11 when processing killlnactiveSessions.

Workaround | Workaround 1: Add a user to the inactivity timer's "Do not terminate these users"
list.

Workaround 1: Back out the changes made by the unload provided for
QCCR1E55852.

Refer to knowledge base article KM1058286 for more information on this Known
Issue.

Service Request Catalog

These are known issues in Service Request Catalog 1.20p1.

QCCR1M957
Title Inconsistent approval behavior.
Problem When there are two line items to approve, if one is rejected, the remaining item is

still pending approval but the entire request is rejected.

Workaround | None available at this time.
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QCCR1M959

Title Behavior of unavailable items.

Problem If an item in a submitted request is deleted or de-activated after the request is in
progress, the unavailable item may not disappear from the request when you
review it. If you add a new item and re-submit the cart, the behavior may correct
itself.

Workaround | None available at this time.

QCCR1M973

Title Incorrect currency display in Japanese and Brazilian Portuguese.

Problem If your currency is set to Japanese or Brazilian Portuguese, the currency format is
not correct.

Workaround | None available at this time.

QCCR1M984

Title Missing item options.

Problem Values for item options do not display for an item in a nested bundle.

Workaround | None available at this time.

QCCR1M985

Title Deactivated item appears in Account Inbox.

Problem A deactivated item remains in the review and pending sections of the Account
Inbox after you submit a request.

Workaround | None available at this time.
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QCCR1M986

Title There is no SRC request URL in email notifications for approved or denied events.

Problem When an email notification is approved or denied, it should include a URL to the
request so the user can open and review the request details. This error occurs
when the approver is an ESS user.

Workaround | You can manually configure the notification to remove the URL, or advise the user
to review the request in their Service Request Catalog Inbox. For more information
about notification configuration, see the Service Manager Tailoring help server
documentation, or Chapter 2 of the HP Service Request Catalog 1.20p1
Installation and Configuration Guide

QCCRIM991

Title Resubmission failure when approval is required.

Problem Request resubmission fails when you remove all original items that require
approval.

Workaround | Do not remove all original items. Leave at least one item that requires approval.
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Fixed Defects

The reference number for each fixed defect is the Quality Center Change Request (QCCR) number.
For more information about fixed defects, visit HP Software Support Online, or contact your HP
Support representative directly.

Applications Issues

These Applications issues are fixed in this software release.

QCCR1E57153

Symptom | Service Manager may update the module licensing stathistory records even when
the data read from the database had not been changed.

Resolution | Service Manager will not update the stathistory record unless the values have been
changed.

Important: To take advantage of the update you must load the QCCR1E55715
SM921p1.unl unload file, which contains the updated application.

QCCR1ES57766

Symptom | During login, Service Manager called the set module licenses function for each
licensed module, which caused many jgroups messages to be broadcast to all
nodes in the group.

Resolution | Service Manager will only perform the set module license call once, passing an
array of all licenses, and reducing jgroups communication.

Important: To take advantage of the update, you must load the QCCR1E57767 _
SM921p1.unl file which contains the updated application. This improvement
requires server change QCCR1E56815.

QCCR1ES59753

Symptom | To Do Bar has dark blue background instead of underline

Resolution | The To Do Bar now has an underline, as expected.

Important: To take advantage of the update, you must load the QCCR1E59753 _
SM921p1.unl file which contains the updated application.
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Fixed Defects

Server Issues

These Serverissues are fixed in this software release.

Application Support Issues

These defects are server application support problems.

QCCR1E48988

Problem

The Service Manager server terminates with an error message when you use a
command line call that exceeds 1024 characters, for example when using
us.launch.external or starting the server at the OS command line.

Solution | You can now invoke Service Manager processes with command line calls that exceed

1024 characters.
QCCR1E56257

Problem | Change requests with related records take much longer to display than Change
requests that have no related records.

Solution | Speeded up the display of Change Requests with related records by limiting the data
returned.

QCCR1E56815

Problem | There are too many calls to the licensing application to causing a lot of JGroups traffic
on login.

Solution | All licensing information is now sent in one RTE call.

QCCR1E56826

Problem | JavaScript global method writeFile() does not handle the binary file operation correctly
when the second parameter contains a "B".

Solution | JavaScript global method writeFile() handles the binary file operation correctly.

QCCR1E56903

Problem | In the Service Manager JavaScript (JS) environment, a user could not concatenate
attachments that contain text value (utf-8 or ascii characters).

Solution | Added a .stringValue property to the JS attachment object. When the attachment
object contains a text value (utf-8 or ascii characters), this new property permits JS
attachment object values to be obtained as ordinary JS strings so they can be printed,
concatenated, etc. and possibly assigned to a different attachment object's value
property. The .stringValue property is not assignable.
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QCCR1E57128

Problem | There is a memory leak when you add a Marquee to a form and then start the servlet
without starting the system.start background process.

Solution | There is no memory leak when using a Marquee.

QCCR1E59712

Problem | When using the index() function on an array that contains more than 65536 elements,
the function internally overruns the array until eventually it hits a stack overflow due to
bad data. At that point, the OS might kill the whole process.

Solution | The index() function properly checks for the end of the array, and does not crash.

QCCR1E59840

Problem | Improve JavaScript performance by adding a class look-up array instead of searching
for the class by name.

Solution | Added a class look-up array to improve JavaScript performance.
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Database Issues

These defects are server database problems.

QCCR1E31

731

Problem

When a user opens the inbox of all open calls, closes one of the tickets, and then
returns to the inbox, the ticket is still in the list of all open calls.

Solution

The record is removed from the search list when a record from the list is updated and
the updated record doesn't qualify for the search criteria. This change will only work as
long as both the search list and the detailed data of individual record or working on the
same tab (RAD thread).

Out-of-box, some of the applications open the details of anincident in a new tab. If you
want the record to be removed, then the application has to be customized so that the
detail data of an object is also shown in the same tab.

Follow these steps to make that customization:

1. Open a Service Manager client and log in with a user that has administrative
privileges, such as falcon.

Open Tailoring > Document Engine > Objects.

In type "probsummary" in the File name field and click Search.

In the probsummary Object Definition , open the Manage Queues tab.
Change "Thread view > Edit?" from "true" to "false".

Save and log out from the client.

N o ok~ 0 D

Log back in and open an incident. You'll see the incident opens in the same pane
as incident queue and also when you update the record search list gets
updated/refreshed.

8. Repeat as desired for other screens.

QCCR1E32072

Problem

Using certain Japanese characters, CJK Unified Ideograph extension B characters (or
Unified Han ldeographs), causes the Service Manager client to disconnect with a
SOAP Fault CXmIApiException.

Solution

The Service Manager client can handle CJK Unified Ideograph extension B characters
(or Unified Han Ideographs).

Important: After adding the new files, you must remove the old ones.
Remove the following .jar files from the "\RUN\lib" directory:

- saaj-impl-2.1.jar

- saaj-api-2.1l.jar

Remove the following .jar files from the "\RUN\lib\endorsed" directory:
- xercesImpl-jaxp-1.3.2.jar

- xalan-jaxp-1l.3.2.jar

- jaxp-api-1.3.2.jar

- dom-jaxp-1.3.2.jar

- sax-jaxp-1.3.2.jar
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QCCR1E49809
Problem | A View (inbox) that is created for a primary file that includes columns and fields from
related tables does not display all the data.
For example, to show the Location Full Name (location.full.name) for Affected Cls in
Incidents in a View, the relationship would be: probsummary > device > location >
location.full.name.
In this case the value of the 3rd level, for example, Location Full Name
(location.full.name), is not shown. Levels 1 and 2 (probsummary > logical.name and
device > location in this case) display correctly.
Solution | A View (inbox) on a primary file (such as incidents), which displays data from other
files, will display the data from related files correctly.
QCCR1ES56053
Problem | When upgrading a file with an array mapped as a blob-in-main but without the RC form
flag set, the upgrade maps the fields inside the array as well. When then opening the
file, Service Manager might repeatedly fail with the following message:
Mapped field " to NULLTABLE in file 'cm3r'.
Solution | Changed the SQL mapping process so that it does not map fields inside an array if the
array itself is already mapped.
QCCR1E56711
Problem | New parameter vj_record_limit should handle a value of 0 to act the same as prior
releases.
Solution | New parameter vj_record_limit handles the value of 0 to act the same as prior
releases.
QCCR1E56817
Problem | A very large virtual join may crash the user's session. The virtual join limit exceeded
message needs improvement, and it does not show up in the log file.
Solution | A new parameter, vj_record_limit:2000, has been created to set a limit to the number of

records that may be contained in a virtual join. The following message will also be
added to the log file, indicating that the limit has been exceeded.

"Exceeded virtual join record limit of %Id records performing action Virtual Join on
form main form subform vjform".
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QCCR1E57127

Problem | When two threads attempt to update the same record at the same time through the JS
method doSave(), one of them will receive a "Modified since read" error message and
could crash.

Solution | The servlet no longer crashes when the JavaScript method doSave() encounters a
"Modified since read" error condition.

QCCR1E57148

Problem | On Oracle, with parameter sqlfetchrows:124 queries with more than 500 records are
truncated at 500 records.

Solution | On Oracle, queries with more than 500 records return all matching records, regardless
of how the parameter sqlfetchrows is set.

QCCR1E57515

Problem | Client crashed when a field was modified through system definition.

Solution | A field can be modified successfully through system definition.

QCCR1E58180

Problem | The JavaScript doSelect() retrieves the records fit to the specified query. BUT it will
retrieve ALL the fields that belong to the target record. If there are many fields with
data type 'structure’ or 'array,' the return speed will be too slow.

Solution | To enable users to specify a list of fields to limit your query, Service Manager now
supports a new constant, SCFILE_ READONLY, which you can provide as a
parameter to the SCFILE object constructor and new method, SCFile.setFields().

QCCR1E58643

Problem | The Windows and web clients terminate when a user updates a record in the Service
Catalog and it no longer matches the QBE criteria. If all active catalog items are listed
via the manage catalog interface and a catalog item has been inactivated, it causes
the client to terminate.

Solution | When a record is updated in the Service Catalog and it does not meet the QBE criteria
anymore, the Service Manager server process will not end with a GPF error.
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QCCR1E59292
Problem | When remapping a single array to a multi-row array table through the dbdict utility, the
dbdict utility would prompt the system administrator witha CREATE TABLE
statement. If the system administrator uses the "SM Alters" option, Service Manager,
when making the dbdict changes, will encounter duplicate table errors from Oracle.
Solution | When remapping a single array to a multi-row array table through the dbdict utility, the
changes will be applied directly without any duplicate table errors by the RDBMS.
QCCR1E59570
Problem | User's session may terminate with a signal 11/GPF when remapping a table using the
dbdict utility.
Solution | Remapping a table using the dbdict utility now works successfully.
QCCR1E59933
Problem | Extactions is a highly used records that is not updated often. Each Web Service may
have to read several records from that database. It should be cached.
Solution | Added extactions to the RTE server table cache to improve performance.

Integrations Issues

These defects are server integrations problems.

QCCR1E53200

Problem

Web services clients that used pooled persistent connections and multiple credentials
intermittently received 401 Unauthorized responses.

Solution

When a new user connects through the same client IP and port, the Service Manager
runtime environment will create a new session to serve the request.

QCCR1E56298

Problem

When using the "/SM/7" Web Services URL, the Service Manager SOAP response
returns an invalid schemalocation URL.

Solution

The schema location in the Service Manager Web service SOAP response contains
correct values.

QCCR1E56837

Problem

External application interfacing via Web Services will not work when it is validating the
Service Manager WSDL for SOAP 1.2 support.

Solution

Service Manager WSDL generation creates the SOAP 1.2 binding for the service.
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QCCR1ES56

843

Problem

Retrieve Web Services requests might not return the requested records, due to
Service Manager building bad queries.

Solution

Retrieve Web Services requests now return the correct records.

QCCR1ES56

847

Problem

When a Service Manager client request contained an attachment with mime type that
was set to "image/bmp," the attachment was added as a Service Manager image type
attachment and could not display in the "Attachments" container.

Solution

When a Service Manager client request contains an attachment with mime type that is
set to "image/bmp," the attachment will be properly displayed in the "Attachments”
container.

QCCR1ES58

608

Problem

A web service using a trusted signon connection will automatically behave as if it had
the SOAP_API capability word.

Solution

A web service connecting via a trusted sign-on enabled connection is not required to
have the SOAP_API capability word in the operator record in order to execute the web.

QCCR1ES59

289

Problem

Retrieving Change records takes a very long time when you are using the SOAP Ul in
place of RC.

Solution

When an extaccess record contains many fields in the exposed field list, response
time degraded significantly.

Service Manager now only processes the "keys" element. This speeds up response
time when there are many exposed fields.

Miscellaneous Issues

These defects are miscellaneous server problems.

QCCR1E28

231

Problem

Server performance is affected when log rotation is in progress. Each user session
writes to the log queue, not to the log file directly. A separate thread reads from that the
log queue and writes the messages to the log file. During log rotation that thread stops
reading from the log queue. The log queue can fill up which causes all other user
sessions to be blocked until log rotation is complete.

Solution

Service Manager now accepts a new parameter, logqueuesize, which controls the
size (measured in number of records) of the log queue. When log queue is sized
appropriately, response time should not degrade during log rotation.
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QCCR1E54365

Problem | When running the Service Managersm -helpall command, there are two
parameters that can be put into the sm. ini file, viewscreennames and
viewformnames, to disable or hide the screen name or form name displayed in the
bottom right hand corner of the Windows client screen. These appeared to work in
ServiceCenter 5.1, but do not work in Service Manager 7.11. It would be helpful to be
able to continue to hide the screen name or form name as needed. These parameters
are still listed in sm -helpall.

Solution | The parameters viewformnames and viewscreennames have been removed from sm
-helpall and should be removed from your sm. ini file.

QCCR1ES55365

Problem | Possible GPF/Signal 11 when using time zone offset names longer than 9 characters.

Solution | Fixed a buffer overrun when handling time zones with time zone offset names that are
longer than 9 characters.

QCCR1E56281

Problem | The field non.keyed.system in the systemtotals table and non.keyed in the
systemperform table that is maintained by the RTE contains inaccurate counts.

Solution | The fields now contain accurate counts.

QCCR1E56442

Problem | A duplicate key error might be encountered when updating a record in a join file, such
as joincomputer or joinsvcDisplay. This only happens when the join file variable was
copied through the fduplicate() RAD function before the update.

Solution | Now join files can be updated without a 'duplicate key' error, even if the join file
variable was copied through the fduplicate() RAD function before.

QCCR1E56455

Problem | Server memory leak when the password decryption fails with error message "RTE E
PKCS12_pbe_crypt() failed in desDecryptPasswordFieldWithMD5AndDes()"

Solution | Fixed a possible server memory leak.

QCCR1E56825

Problem | LDAP mapping for the default operator template is not automatically creating operator
records on login. LDAP query is working, but the operator create is failing on insert.

Solution | LDAP mapping for the default operator template automatically creates operator
records on login.
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QCCR1E56979

Problem | Service Manager server accepted non-SSL Web Services requests when the Service
Manager ssl:1 parameter was set.

Solution | Service Manager server will reject all non-SSL Web Services requests when the SSL
connection is enforced in the Service Manager Server (ssl:1).

QCCR1E57705

Problem | The Windows and web clients may make a redundant getData call to get the
attachment information, because the executeReponse does not contain the
attachments information.

Solution | Emit <attachments> on executeResponse if form has the container. This allows the
client to not make an additional getData request.

QCCR1E58043

Problem | When Service Manager is configured in horizontally scaled mode and two nodes start
up on different hosts at the same time, one of the nodes might report a "duplicate
object" error from the RDBMS. This happens when Service Manager attempts to
determine whether it has CREATE TABLE rights on the RDBMS.

Solution | Service Manager now generates a unique table name using the host name when
determining the CREATE TABLE rights. This prevents the "duplicate object" error.

QCCR1E58426

Problem | Web Services that use a Self Service enabled operator should be counted as an
unlimited user and not a floating user.

Solution | A web service that uses an operator record that has the Self Service Access Only
check box enabled is counted as an unlimited user.

QCCR1E59226

Problem | The ServiceCenter 6.2 Legacy listener may GPF in _checkForTruncation() due to a
null pointer.

Solution | The ServiceCenter 6.2 Legacy listener no longer has a GPF errorin _
checkForTruncation() due to a null pointer.

QCCR1E59394

Problem | The client occasionally crashes if the user pressed the Fill button while a pop-up form
was trying to display.

Solution | When the user presses the Fill button prior to the pop-up form being displayed, the Fill
operation successfully completes.
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QCCR1E60056

Problem | After a binary update to 7.11p15, incidents that contained two or more attachments do
not display those attachments if they are on a subformat added to the Incident >
Attachments tab. New incidents with two or more attachments will also not display
those attachments. The SYSATTACHMENTS table contains the correct
attachments.

Solution | Populating the subform information to the main form so the attachments can now be
displayed correctly.

Resilience Issues

These defects are server resilience problems.

QCCR1E53385

Problem | Archived log files vary significantly in size.

Solution | Log files are now archived at the specified log file size.

QCCR1E53886

Problem | If multiple processes were started at the same time, some processes could not join in
JGroup.

Solution | Added a sleep statement to the smstart script so that processes do not all start at the
same time. Now all background processes and schedulers can properly join the
JGroups view.

QCCR1E54373

Problem | A Tomcat thread servicing a SM connection might leak 4 bytes.

Solution | Fixed a potential memory leak of 4 bytes in Tomcat threads.

QCCR1E55366

Problem | A signal 11/GPF might be encountered when afloat is printed to the log file with more
than 20 digits.

Solution | Floats are successfully printed to the log file even if they have more than 20 digits.

QCCR1E56661

Problem | When you use rolling log files, you cannot tell from the numbering which is the oldest or
newest.

Solution | The current log file is now archived to the log file ending with 1, and the existing log
files are renamed to the next higher number, so that the archive log file n+1 always
contains older data than archive file n.
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QCCR1E56868

Problem

XML response is created in native code and passed to java code which reparses the
XML response to construct a DOM object. This process is very expensive regarding
both memory and CPU usages.

Solution | Improved CPU and Memory utilization of Java Heap by removing reparsing of

response XML.
QCCR1E56953

Problem | Running the command sm -reportshm caused a signal 11 after correctly reporting on
shared memory.

Solution | The command sm -reportshm no longer causes a signal 11.

QCCR1E57246

Problem | It takes a very long time to start Service Manager server as a service on Linux with
Solaris when using the parameter memdebug:400.

Solution | A Service Manager process with the parameter memdebug:400 no longer checks
addresses from the stack by default. This speeds up the server start time.

QCCR1E57406

Problem | Service Manager JavaScript methods doSOAPRequest and doHTTPRequest caused
the Service Manager client to crash if the user specified a bad URL location for
requests.

Solution | The Service Manager client does not crash if the JavaScript methods
doSOAPRequest or doHTTPRequest encounter an http request error.

QCCR1E57848

Problem | The Service Manager server crashed when trying to format a message that contained
more than 16 arguments.

Solution | The Service Manager sever no longer crashes when trying to format a message with
more than 16 arguments. Service Manager can now format messages with as many
as 32 arguments. When a message has more than 32 arguments, Service Manager
logs an error and truncates the message.
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QCCR1E58842

Problem

One Service Manager process' failure to attach to shared memory caused that process
to destroy shared memory. Afterwards, no new processes or threads could start,
because they could no longer attach to shared memory.

Solution

Only the sm -shutdown command destroys shared memory on UNIX. If an attach to
shared memory fails on HP-UX, a dump of the process' address space is printed to the
log file for troubleshooting.

Startup Issues

These defects are server startup problems.

QCCR1E54322

Problem

Messages written by third party libraries to stdout/stderr are missing. When a Service
Manager process is started by "smstart" script, the processes stdout and stderr are
redirected to a process<n>.log, but when they are started using sm commands they
are not.

Solution | The Service Manager server has been modified so that during startup, the Service
Manager process redirects these to a process<n>.log or sm_pid_stdouterr.log in the
logs directory.

QCCR1E55113

Problem | When debugdbquery is turned on and a RAD thread is destroyed or not present, a
user's session crashes with signal 11.

Solution | When debugdbquery is turned on and a RAD thread is destroyed or not present, a
user's session will remain active.

QCCR1E56506

Problem | The operator table "last.login" field is not updated when the user logs in with Trusted
Sign-On credentials.

Solution | When a user logs in with Trusted Sign-On credentials, the operator table "last.login"
field is properly updated.
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QCCR1E58279

Problem | The IP based license does not work in horizontal scaling after applying Service
Manager 9.20.patch 1. The non-load balancer host server will not start up due to a
licensing issue on the applications server. The load balancer server does start.
Error Messages:

12469( 12469) 10/19/2010 13:13:36 JRTE | License is validated locally with
ipAddress NN.NNN.NN.NN

12469( 12469) 10/19/2010 13:13:36 JRTE E License is valid locally, but none of the
nodes in the cluster has validated the license on host NN.NNN.NN.NN

12469( 12469) 10/19/2010 13:13:36 RTE E HP Service Manager is unable to start.
Failed to initialize or attach to shared memory environment

12469( 12469) 10/19/2010 13:13:36 RTE E Failed validating license(either locally orin
the cluster). Terminating the process

Solution | The IP based license now works properly.

QCCR1E59521

Problem | Load balancer won't start on Linux systems.

Solution | Added two new Service Manager Server parameters: usealtsignalstack and
usemembar.

Note: These two parameters only apply to UNIX platforms.

By default usealtsignalstack is tumned on for all the UNIX platforms.

The default value for usemembar in LINUX is 1 (starting JVM with option -

XX :UseMembar).

The default value for usemembar in all the other UNIX platforms is 0 (starting JVM
without option -xX : UseMembar).

Important: HP recommends that you set these parameters in the sm. ini file.

Web client Issues

These Web client issues are fixed in this software release.

QCCR1E31479

Symptom | When using the web client with telephony activated and an incoming call arrives, the
following message is received: "You have an incoming call. Do you want HP
Service Manager to respond to the call?" The call center operator has to push the
"Answer" button on the telephony application to answer the call. We want to have
the call automatically accepted.

Resolution | Incoming web client telephony calls are now accepted automatically. The call center
operator no longer needs to push the answer button to accept the call.

QCCR1E32132

Symptom | The value is not saved when you edit Advanced Filter criteria.

Resolution | The value is now properly saved when you edit Advanced Filter criteria.
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QCCR1ES52

769

Symptom

In the web client, fields with mandatory conditions do not appear on the
Configuration Item (ClI) form.

Resolution

Mandatory combo box fields are now displayed by the web client, when they are
read-only.

QCCR1ES52

846

Symptom

Text input field with Mandatory Condition does not display with Print Page from web
client.

Resolution

Text input field with Mandatory Condition now displays properl7 in the Print Page
from web client.

QCCR1E54

810

Symptom

Service Manager web client is using LWSSO 1.x but LW-SSO1.x version cannot
work on non-domain environments, which will affect the SLICK solution.

Resolution

Service Manager web client is now using LWSSO 2.4, as required.

QCCR1E57

012

Symptom

Button caption conditions don't work properly in the web client. If you add a button to
a form and use a caption condition to determine whether to display it, in the web
client, an empty space is displayed instead of the variable value.

Resolution

Button caption dynamic view dependencies work properly in the web client.

QCCR1ES57

079

Symptom

Button ID conditions for standard push buttons do not work. The Button ID is not
changed when the variable on which the condition depends changes.

Resolution

Button IDs are now assigned and act upon based on the condition field.

QCCR1ES57

080

Symptom

Buttons with no default Caption assigned are rendered poorly.

Resolution

Buttons with no caption assigned are correctly rendered.

QCCR1E57208

Symptom

Searches using the Find button don't work for read-only fields on the web client.

Resolution

Using the Find button to search on read-only fields now works properly in the web
client.
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QCCR1E57253

Symptom | Multiselect record lists sometimes display two checkboxes for each row, one
checked, one not checked.

Resolution | Record lists in the web client now only display one checkbox for multi-select tables,
which is either checked or unchecked, as set by the user.

QCCR1E57358

Symptom | Inthe web client, if you click the X button on a tab for an item found in a search list,
the record is not released, and you are returned to the list. The only way to unlock
the record is to wait for the session to time out, or log out and then log in again to kill
the session.

Resolution | If you click the X button on a tab for an item from a search list, Service Manager
releases the record and returns you to the previous detail form.

QCCR1E57478

Symptom | Combo and Comfill buttons are not displayed when their state changes from
readonly to editable.

Resolution | Combo and Comfill buttons are displayed properly when their state changes from
readonly to editable.

QCCR1E57512

Symptom | Caption conditions do not work properly for web client combo boxes. For example,
the web client comfill field displays an empty text box with no value when in read-
only mode, if the field uses a value list condition that contains a dynamic select
function.

Resolution | Readonly comfill field displays the value.

QCCR1ES57546

Symptom | Deflater causes an out-of-memory error.

Error message:

Exception in thread "Timer-43" java.lang. OutOfMemoryError
at java.util.zip.Deflater.init(Native Method)

at java.util.zip.Deflater.<init>(Deflater.java: 117)

Resolution | The Inflater/Deflater objects are now released in time, so the out-of-memory error
will not occur.

QCCR1E58385

Symptom | Unable to close application thread tabs programmatically.

Resolution | Thread tabs can be programmatically closed.
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QCCR1E58434

Symptom

When changing a group background color to any other color except white, it looks
okay in the Windows client. However, it looks very messy in the web client. When a
user tries to expand the group, the details end up behind the other groups.

Resolution | Fixed the functionality of the background color for the Group and Frame widgets in
the web client.
QCCR1ES58547
Symptom | Filtering for a record list results in no response and a blank page.
Resolution | Filtering for a record list will display the results by the applied filter.
QCCR1E58641
Symptom | Inthe web client, a user creating a document through the Contribute Knowledge
after going to Categorization loses the ability to submit/save the document, and the
buttons change.
Resolution | Inthe web client, a user creating a document through the Contribute Knowledge
after going to Categorization can successfully submit/save the document.
QCCR1E58882
Symptom | Users are not getting to the logout.jsp screen using TSO on the Service Manager Web Tier
9.20.052. When the inactivity background process terminated idle users, it logged them back
in again and their URL changed, as follows:
Initial URL:
https://tvmx6748.test.sprint.com/sm/ess.do
After timeout:
https://tvmx6748.test.sprint.com/sm/ess.do?login_error=1&login_error_
message=You%20have%20been%20logged%200ut%20due%20t0%20session%20timeout.
Resolution | Session timeouts redirect to the goodbye page.
QCCR1E59317
Symptom | Web client hangs when attempting to move to the second page of a list of Affected
Services in an interaction.
Resolution | The requested URL is too long.
QCCR1E59646
Symptom | Session timeout message displays messy characters in the L10N environment.
Resolution | The code has been fixed so that a session timeout message displays correctly in

the L10N environment.
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Windows client Issues

These Windows client issues are fixed in this software release.

QCCR1E8737

Symptom | Inthe Windows client, focus is not being returned to the correct tab in a notebook
after afill is performed on an element inside a structured array. Instead, the focus is
being returned to the first tab in the notebook.

Resolution | After performing a fill operation for an array element contained within a notebook,
focus will be returned to the notebook page from which the fill operation was
initiated.

QCCR1E32314

Symptom | When you opened a magnify window and tried to change the data in the record by
using the Fill option, an unrecoverable error occurred.

Resolution | This error no longer occurs when you update a record in the magnify window by
using a Fill.

QCCR1E51883

Symptom | The cursor.field.contents() function does not return the correct data for Text, Combo
Box, Date, and Multi-Line Text Objects if the cursor was previously placed in a
ComFill Object.

Resolution | The cursor.field.contents() function can return the correct data for Text, Combo Box,
Date, and Multi-Line Text Objects if the cursor was previously placed in a ComFill
Object.

QCCR1E54930

Symptom | Exporting to Excel does not work when you run Service Manager from a shared
network drive. You get the following error message: "Can't Generate Excel." This
happened because exporting to Excel required write access to the folders where
Service Manager is installed.

Resolution | User can export to Excel in a local folder when running Service Manager installed on
a remote shared folder.

QCCR1E55822

Symptom | The group view collapses when you select a record for display in the Windows
Client.

Resolution | The group view now highlights the row when you select a record.
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QCCR1E57551

Symptom | If users tabbed to a document in a search list and pressed Enter, the document did
not open. Instead the cursor was returned to the search string.

Resolution | User can tab to a document in a search list and open it by pressing the Enter key.

QCCR1E58561

Symptom | The old style menus display as notebooks instead of sections.

Resolution | The old style menus display as sections.

Service Request Catalog Issues
These Service Request Catalog issues are fixed in this software release.
Attachment Issues

These defects are attachment problems.

QCCR1M956

Title Attachments with long names are not truncated properly.

Description | When an attachment has a long name, the name should truncate instead of
triggering a scroll bar to appear.

QCCRIM963

Title An internal error occurs.

Description | The application generates an error when you attempt to view an attachment on a
support request details page.

Currency Issues

These defects are currency display problems.

QCCR1M842

Title Item Description and Currency is running into each other.

Description | Formatting is incorrect.
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QCCR1M961
Title Incorrect price display in CYN currency.
Description | If your currency is set to Chinese yuan, the displayed price is not accurate.
QCCR1M962
Title Incorrect price display in CYN currency.
Description | If your currency is set to Chinese yuan, the displayed price in the Dashboard is not
accurate.

Price Issues

These defects are price problems.

QCCR1M897

Title Incorrect price on a saved item.

Description | The price of an item changes to zero when you save it.
QCCR1M899

Title Incorrect formatting.

Description | The price of a saved item repeats in the item options.
QCCR1M911

Title Varying prices for items.

Description | Item option prices and total prices change arbitrarily.
QCCR1M912

Title Displayed total errors.

Description | The checkout price and the total on the pending approval tab do not match.
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Miscellaneous Issues

These defects are miscellaneous problems.

QCCR1M484

Title Approval error.

Description | Approval sequence doesn't work as expected when more than two approval
activities (sequence also larger than two) are defined for one request level approval.

QCCR1M786

Title E-mail notification does not work correctly.

Description | The Service Manager server generates an internal error.

QCCR1M793

Title Approved item shows status of "Pending Approval."

Description | The line item status does not match the actual status of the item.

QCCR1M882

Title Incorrect display of active catalog items.

Description | Submitted Item does not appear to exist in the catalog but when you check through
SM client, it's still active.

QCCR1M958

Title An internal error occurs.

Description | If you embed a percentage sign in a search string, the application generates an
error message.
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Request Issues

These defects are Request problems.

QCCR1M892

Title Formatting error.

Description | Checkbox with long name is causing the Request section to be misaligned.

QCCR1M895

Title Erroneous item appears in request status.

Description | Aninactive item shows up in request status page.

QCCR1M960

Title Incorrect "request for" identification.

Description | If you request on behalf of a department, the name of the department should appear
instead of the name of the requestor.

Category Issues

These defects are related to Categories.

QCCR1M869

Title You should be able to see all categories related to your user role.

Description | User roles assign permission to request certain items that are organized into
categories. Although you can search for, and request, these items, their parent
categories may not appear in the category browser if access permission to view the
category is not granted in addition to permission to request the item.

QCCR1M900

Title Server error occurs.

Description | An unhandled error occurs if you search for an item that does not belong to a
category.
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QCCR1M909

Title

Support categories do not appear on the Support tab.

Description

New support categories do not appear correctly.

Page 41 of 42

HP Service Manager (9.21p1)






	HP Service Manager 9.21p1 Release Notes
	Contents
	Overview
	What's New in This Release?
	Service Request Catalog


	Installation
	Web tier update
	Windows client update
	Server update
	Applications update
	SRC Update

	Known Issues
	Service Manager
	QCCR1E58335
	QCCR1E58336
	QCCR1E60525
	QCCR1E60816
	QCCR1E60844
	QCCR1E60849
	QCCR1E60925
	QCCR1E60931
	QCCR1E60934
	QCCR1E60986

	Service Request Catalog
	QCCR1M957
	QCCR1M959
	QCCR1M973
	QCCR1M984
	QCCR1M985
	QCCR1M986
	QCCRIM991


	Fixed Defects
	Applications Issues
	QCCR1E57153
	QCCR1E57766
	QCCR1E59753

	Server Issues
	Application Support Issues
	QCCR1E48988
	QCCR1E56257
	QCCR1E56815
	QCCR1E56826
	QCCR1E56903
	QCCR1E57128
	QCCR1E59712
	QCCR1E59840

	Database Issues
	QCCR1E31731
	QCCR1E32072
	QCCR1E49809
	QCCR1E56053
	QCCR1E56711
	QCCR1E56817
	QCCR1E57127
	QCCR1E57148
	QCCR1E57515
	QCCR1E58180
	QCCR1E58643
	QCCR1E59292
	QCCR1E59570
	QCCR1E59933

	Integrations Issues
	QCCR1E53200
	QCCR1E56298
	QCCR1E56837
	QCCR1E56843
	QCCR1E56847
	QCCR1E58608
	QCCR1E59289

	Miscellaneous Issues
	QCCR1E28231
	QCCR1E54365
	QCCR1E55365
	QCCR1E56281
	QCCR1E56442
	QCCR1E56455
	QCCR1E56825
	QCCR1E56979
	QCCR1E57705
	QCCR1E58043
	QCCR1E58426
	QCCR1E59226
	QCCR1E59394
	QCCR1E60056

	Resilience Issues
	QCCR1E53385
	QCCR1E53886
	QCCR1E54373
	QCCR1E55366
	QCCR1E56661
	QCCR1E56868
	QCCR1E56953
	QCCR1E57246
	QCCR1E57406
	QCCR1E57848
	QCCR1E58842

	Startup Issues
	QCCR1E54322
	QCCR1E55113
	QCCR1E56506
	QCCR1E58279
	QCCR1E59521


	Web client Issues
	QCCR1E31479
	QCCR1E32132
	QCCR1E52769
	QCCR1E52846
	QCCR1E54810
	QCCR1E57012
	QCCR1E57079
	QCCR1E57080
	QCCR1E57208
	QCCR1E57253
	QCCR1E57358
	QCCR1E57478
	QCCR1E57512
	QCCR1E57546
	QCCR1E58385
	QCCR1E58434
	QCCR1E58547
	QCCR1E58641
	QCCR1E58882
	QCCR1E59317
	QCCR1E59646

	Windows client Issues
	QCCR1E8737
	QCCR1E32314
	QCCR1E51883
	QCCR1E54930
	QCCR1E55822
	QCCR1E57551
	QCCR1E58561

	Service Request Catalog Issues
	Attachment Issues
	QCCR1M956
	QCCRIM963

	Currency Issues
	QCCR1M842
	QCCR1M961
	QCCR1M962

	Price Issues
	QCCR1M897
	QCCR1M899
	QCCR1M911
	QCCR1M912

	Miscellaneous Issues
	QCCR1M484
	QCCR1M786
	QCCR1M793
	QCCR1M882
	QCCR1M958

	Request Issues
	QCCR1M892
	QCCR1M895
	QCCR1M960

	Category Issues
	QCCR1M869
	QCCR1M900
	QCCR1M909




